
 

 

 

Advanced EMR and Billing Solutions for Behavioral Health              pg. 1 

 

Phone: 800-850-8510 
Fax: 888-415-7939 

www.TMDTIGroup.com 
 
 

1800 Dual Highway, Suite 306, Hagerstown, MD 21740 
 
 
 
 

 
 

 
 

Quic Doc® 

Practice Made Perfect 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Help Guide 
  



 

 

 

Advanced EMR and Billing Solutions for Behavioral Health              pg. 2 

 

Contents 

Introduction .................................................................................................................................................. 3 

Technical Support ........................................................................................................................................ 4 

Running QuicDoc, System Administrator Function ...................................................................................... 5 

Overview of QuicDoc ................................................................................................................................... 5 

Getting Started ............................................................................................................................................ 8 

Report Headers ........................................................................................................................................... 8 

Preferences ................................................................................................................................................. 8 

Documentation Setup .................................................................................................................................. 9 

User Setup .................................................................................................................................................. 9 

Insurance Companies Setup...................................................................................................................... 10 

Referral Source Setup ............................................................................................................................... 11 

Patient Setup ............................................................................................................................................. 11 

Creating Notes and Treatment Plans ......................................................................................................... 12 

Documentation Basics ............................................................................................................................... 12 

Electronic Signatures ................................................................................................................................. 15 

Intake Notes .............................................................................................................................................. 15 

Progress Notes .......................................................................................................................................... 16 

Separate Psychotherapy Notes ................................................................................................................. 16 

Treatment Plans ........................................................................................................................................ 16 

Discharge Notes ........................................................................................................................................ 17 

Batch Printing Clinical Notes and Treatment Plans .................................................................................... 17 

Group Notes .............................................................................................................................................. 18 

Add Members to Group ............................................................................................................................. 18 

Creating Group Notes ................................................................................................................................ 19 

QuicForms Treatment Plans ...................................................................................................................... 20 

Outcome Measures ................................................................................................................................... 23 

Score and Print Patient Satisfaction Survey ............................................................................................... 25 

QuicDoc Scheduler .................................................................................................................................... 26 

Backup Recommendations ........................................................................................................................ 28 

 

 
 
  



 

 

 

Advanced EMR and Billing Solutions for Behavioral Health              pg. 3 

 

Introduction 
 

Welcome to QuicDoc® the comprehensive documentation and outcome assessment system for the mental 
health professions. Use QuicDoc to document patient care from Intake to Discharge, track authorizations, 
maintain your appointment schedule, score and track outcome/progress measures, generate reports, and 
more. Complete your treatment plans and submit them on the required OTR form using QuicForms. 
 

About This Start-Up Guide 
 

The Start-Up Guide serves as an introduction and contains information to get you up and running quickly. It 
was designed to provide the basics only. Comprehensive, context-sensitive Help is available by selecting 
Help Topics from the Help menu or pressing F1 from any screen.  You may also visit our online 
Knowledgebase for up to date help guides.  Throughout this guide System Administrator will be 
abbreviated as SA, and the System Administrator’s logon as Administrative logon. This guide assumes you 
are familiar with the Microsoft Windows Operating System. 
 

QDPM Users 
 

There will be some items in this guide that will not be available if you are using our billing software, QDPM.  
All patient demographics and scheduling MUST BE entered directly into the QDPM software as it is 
integrated with QuicDoc.  Patient demographics and the schedule will be read only.  Any changes that 
need to be made to these items, you will need to go directly into QDPM program. 
 
 

 
  

http://www.docutracinc.com/kb/index.php?/
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Technical Support 

 
If you have a question about QuicDoc, first look in: 

The QuicDoc Help Guide 
The QuicDoc Help Topics found in the Help menu 
The QuicDoc online videos can be found at https://www.youtube.com/user/DocuTrac/videos  
The QuicDoc online Knowledgebase found at http://www.docutracinc.com/kb/index.php?/ 
 

 
Information to have ready: Before you call DTI support services with a problem or a question on how to 
use 
QuicDoc, be at your computer with QuicDoc running. Be prepared to give the following information: 

• Type of computer hardware you are using. 

• Version of Microsoft Windows and/or Mac OS you are using. 

• Exact wording of any messages that appear on your screen. 

• A complete description of what happened and what you were doing when problem occurred. 

• The printer manufacturer, type, and model, if relevant to your problem. 

• Your network configuration, if any. 

Support Hours 
Mon - Fri: 9:00 AM to 5:00 PM, EST 
If you have a problem or cannot find an answer in the Help Guide or On-Line Help: Contact TheraManager 
DocuTrac Support Services at 888-308-9683. 
 

 
  

https://www.youtube.com/user/DocuTrac/videos
http://www.docutracinc.com/kb/index.php?/


 

 

 

Advanced EMR and Billing Solutions for Behavioral Health              pg. 5 

 

Running QuicDoc 
 

Log onto QuicDoc with either the Administrative ID and Password or your User ID and Password. 
 
The Administrative logon allows access to all patient lists, records, and to all parts of the program with the 
exception of Continuing Education tracking in the User window. SA tasks include: 
 

• Register the software 

• Add new users 

• Set access levels 

• Make users inactive or delete them 

• Check users logged on to QuicDoc (network) 

• Optimize and repair databases 

• Set electronic records option 

• Setup providers work schedules 

• Reassign clients to a different provider 

• View and Purge the Audit Log 

• Set SA Preferences 

• User Forms and Documentation Setup 

• Custom Outcome Measures 

• Create and Edit Document Templates 

Your user logon gives you access to just your patients and the ability to create and edit notes for those 
patients. By default, when you open the patient information window to add new clients, you will be listed as 
the provider of service. 
 
A Reminders window displays once you log onto QuicDoc. It will list your daily appointments, treatment 
plans that are due, authorizations with fewer than 2 weeks remaining, and tasks you have setup in the 
Scheduler. You can close the reminders window. You can configure QuicDoc to not display the Reminders 
screen at opening by visiting the Preferences window, from the Setup menu. 
 

Overview of QuicDoc 
 

QuicDoc's main interface consists of five views with context sensitive menus and toolbars. The opening 
view is the Patient or Client window. Click to open the Views menu and select a view. 

 
 
The vertical splitter can be resized and moved vertically to hide the patient list. You can also hide the 

patient names by clicking on the  icon to the right of the Find box at the top of the screen. The right 
side, middle, horizontal splitter can also be moved to display more or less information. 
 
Contact information, emergency information, and current diagnosis and medications for a selected client 
are displayed in the upper right pane. 
 

 The Find field at the top of the window allows you to quickly search 
the patient list for a specific name.         
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 Click to expand the Tasks list for frequently used features. 
 

 Use the Help icon at the top, right of the window to quickly access the Help files. 

 Patients: The Patient window is the opening screen in QuicDoc. You can view and access all clients 
along with address and phone numbers, emergency contact, session or note history, current diagnosis and 
medications, insurance authorizations, necessary tasks, attached documents, and any cautionary notes for 
a specific patient. 
 

 Users: The User window displays identifying information for an individual user, or with the 
Administrative logon, a list and information for all users including work schedules. 
 
Continuing Education Tracking: Users can record and conveniently keep track of their continuing education 
units. 
The program, location, dates, and number of units is all displayed in an entries list box. This feature is not 
available when using the Administrative logon. 
 

 Referrals: The Referrals window displays your Referral Source list and information you have entered 
for each referral. It also displays a list of all patients that were referred by the selected referral source. 
 

  Insurance: The Insurance window displays your Insurance Company list and information for each 
company. It also displays a list of patients associated with a selected company. Enter Managed Care 
Companies, from which you will be receiving session authorizations, as Insurance Companies. QuicDoc 
consolidates both managed care and insurance companies into one list. 
 

 Pharmacies:  The Pharmacy window displays the Pharmacy list and information you have entered for 
each pharmacy. If applicable, Pharmacies added here are for the written prescriptions entered in QuicDoc.  
By default the Pharmacy window is disabled.  To enable the Pharmacy, log into the SA account.  Under 
Setup select Preferences.  It will be under the Administrative tab.   
 

 Groups 
  
 
 
The Groups window will display a list of groups that you set up. When 
you click on the + next to the group name, the list expands to display the 
members and dates each member was added to the group. 
 
 
 

 
 

 e-Prescribe: The Electronic Prescribing System in QuicDoc will allow a doctor to prescribe 
medications and transmit them to a pharmacy using electronic connection over the internet or using 
automatic faxing. In addition, the prescriber may also print prescriptions.  For information on e-Prescribing, 
please contact Sales at 800-850-8510. 
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All Views 
 
All of the QuicDoc Views have a Find field in the top pane of the window, as well as a tasks side menu for 
frequently accessed features. 
 
Toolbar: The context sensitive toolbar allows you to launch frequently used features from the main 
windows. 
 
Menus: QuicDoc's context sensitive menus change according to the available features for the current or 
active window, Patients, Users, Referral Sources, or Insurance Companies. 
Pop-up menus can be accessed by right clicking with your mouse. For example, right click on the patient 
list to display a menu that lets you edit information, find a patient, schedule tasks, etc. Right click in text 
fields for edit menus, or right click in the Notes History tab to create or open clinical notes. 
 
Documentation – Patient View 
 
Notes and treatment plans are listed in the Patient window in a tabbed area at the bottom, right of the 
window for easy access. QuicDoc includes complete documentation from Intake to Discharge, including 
Progress Notes, 
DAP and SOAP formats, Treatment Plans, Inpatient and Outpatient, Missed Appointment, and Incidental 
Notes. 
(OTR forms are listed in QuicForms.) 
 

 
 
Additionally the tabs include a tab for the Authorizations, Tasks, and one for Documents. The Documents 
tab lists all files created from templates and merged with client information (e.g. Release of Information 
form). 
 
QuicDoc’s complete documentation also includes: 
 

Separate Psychotherapy Notes 
Disclosure of Protected Health Information 
QuicForms, OTR forms for Treatment Plans 
Missed Appointment Notes 
Incidental Notes 
Other - User Defined Notes 

 

 Scheduler:  With QuicDoc’s Scheduler you can create therapy and group therapy appointments, 
schedule events, meetings, activities, tasks, and availability. You can even schedule blocks of time for 
specific types of appointments, such as medical evaluations, and then create appointments within the time 
block. There is a room scheduler to help manage your resources. You can view your schedule by day, 
week, or month. There is also an all provider view. 
 
Assessments and Outcome Measures 
 
QuicDoc includes outcome measures to track patient or client progress, as well as other assessment tools 
such as the Crisis Triage Rating Scale, a Pain and a Nutrition assessment. 
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Reports 
 
QuicDoc will generate a number of reports based on data you enter for patients and on information you 
enter while documenting sessions. QuicDoc’s reports include: 
 

Quality Assessment   Outcome Measures 
Demographics    Client Satisfaction 
Diagnosis   Missed Appointment 
Medications    Contact Hours 
Referral source    Demographics Report 

 
The Audit Log report allows you to track and audit user activity in the program. It requires the 
Administrative 
Logon.  The Audit Report logging can be turned on or off by logging into SA account.  Select the Setup 
menu, and the click on preferences.  It will be located under the Administrative tab, ‘Audit Report logging.’ 
 
Tracking Features 
 
In addition to client or patient progress and quality assessment, QuicDoc can track the following: 
Authorizations, 
Treatment Plans, Continuing Education Credits, tasks, calls, appointments, and sessions that need to be 
documented, Protected Health Information, client specific documents, activity in the program, and more. 
 

Getting Started 
 

You can begin by setting up a report header, and you may also want to set your preferences. Then you can 
complete the user setup, and add insurance companies and referral sources. 
 
Report Header 
 
This appears at the top of all notes and reports. You can also enter alternate headers, and change the 
default setting. The first header entered is the default header. 
 
To Add a Header: Select Report Headers from the Setup menu. 
 
Type the header in the text box. Use the Enter key to begin a new line. You can have any number of lines. 
Click Save. If you are only entering one header then click Close to exit. 
 
Alternate Report Headers 
 
Click New. You will see the numbers at the top change from 1 of 1 to 2 of 2. You can have any number of 
Report 
Headers, with one being the default header. Enter another header. Click Save. 
 
Preferences 
 
You can set preferences for Reminders, Treatment Plan notification, Links, and Tasks, as well as 
Administrative preferences including Electronic Records (signatures) and password options which require 
the Administrative logon. 
 
To set preferences from the Setup menu select Preferences. While in the Preferences window, press F1 
for Help and detailed information regarding options. 
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Documentation Setup 
 
You can setup Notes and Treatment Plans in QuicDoc to reflect your individual needs by selecting which 
clinical sections you want to appear in the listbar or side menus. For instance, if you never do 
Psychological Testing, you can remove that section from the menu. The Documentation Setup also allows 
you to create notes of your own design and name, aside from those that are in the program by default. 
 
First familiarize yourself with the different clinical sections in QuicDoc. You will need to have entered at 
least one patient before you can access the Documentation area of the program. To access the setup go to 
Setup…Documentation Setup in the Patient window. You will need to logon with Administrative logon. 
Press F1 for help or visit our online Knowledgebase for more information on Documentation setup. 
 
User Forms 
 
The User Forms option in QuicDoc allows the user to create forms or sections to be added to either a pre-
existing note type or a user defined note type which will be done in the Documentation Setup. You can find 
the User 
Forms option by going to Setup…User Forms while logged in with the Administrative ID. There is a tutorial 
on the User Forms but you can also consult the Help Files for additional questions by pressing F1 while the 
User 
Forms screen is open or visit our online Knowledgebase. 
 
Users 
 

Setup Users:  Log onto QuicDoc with the Administrative ID and password to add new users. When you 
add a new user, you will assign a User ID and password, and you set appropriate levels of access. 
 
Note:  If you are using QDPM, the provider’s User setup in QuicDoc will not sync to QDPM.  You will need 
to enter the Provider’s name in both programs and MUST identical.  When making changes 
 
Click Users on the View menu bar or select it from the View menu. 
 

  Click the Tasks sidebar to expand, and then select Add a user, or you can select New User 

from Users menu. 

 Enter information in the fields. The (logon) User ID, Name, and Password are the only fields 

required.   

User ID: Can be from 3 to 5 alpha numeric characters.   

The ID entered becomes the logon ID for the user to start QuicDoc. It cannot be changed.   

User Name: Appears at bottom of printed notes and reports. It can be edited. 

 The DEA# appears on Prescriptions when the option is selected in the Print Prescription window. 

Passwords for New Users 
 
Enter and verify a password using 4-20 alphanumeric characters. The password can be changed later by 
first logging on with the password and then going to File...Administration...Change Password. 
 
Passwords do not need to be unique however it is advisable to make all passwords unique. 
 

  

http://www.docutracinc.com/kb/index.php?/
http://www.docutracinc.com/kb/index.php?/
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Access Levels 
 
By default, every new user has the highest access level (Write-Delete) assigned for each of the 9 content 
areas. 
To modify access levels: Log into the Administrative account, from the sidebar Tasks menu, select Set 
user access levels. 
 
Select access levels for the user, and click OK to save. See Help Files for details on setting access levels 
or visit our online Knowledgebase. 
 
User/Provider Work Schedule 
 
Note:  If you are using QDPM, the provider’s schedule will need to be setup in QDPM.  Information from 
QuicDoc scheduler will not sync to QDPM.   
 
To set up a user’s work schedule, click the Tasks item Set user work schedule. 
 

• Enter the start and the end times for the work days of the week. Non-working days should be left 
blank. 
• Click in the Start field, and enter the time. The format should be hh:mm.  Type the letter a for am 
and the letter p for pm. You do not have to type the 00 if you are entering a time on the hour. For 
example, simply type 09a for 9:00 am or 05p for 5:00 pm. 
 

The work times will be indicated in the Scheduler time slots as yellow. Non-working times will be indicated 
as grey. The work schedule appears for each selected provider in the bottom, left pane of the Users 
window. 
 

Insurance Companies 
 
Note:  If you are using QDPM, you will want to setup the Insurance Companies via QDPM.  This 
information inputted into QuicDoc will not sync to QDPM.   
 
QuicDoc consolidates both managed care and insurance companies into one list. Insurance and managed 
care companies can be added 'on-the-fly' as you enter new clients, or you can set them up. 
 
Setup Insurance Company 
 
Click the Insurance button on the toolbar, or select Insurance Companies from the View menu. From the 
Insurance window, click Tasks on the side menu to open, and then select Add insurance co., or you can 
select 
New Insurance Co from the Insurance Cos menu. 
 
Enter information, and click Ok to save. 
 
Edit: Double click on name in list to open information form, or click on the side Tasks menu item Modify 
insurance info. Make changes, and click Ok to save. 
 
Delete: Select the name in the list. Select Delete Insurance Co from the right mouse-click menu or 
Insurance 
Cos menu. Click Yes in dialog box to delete. If an insurance or managed care company is associated with 
one or more clients, you will not be able to delete, instead you can make the company inactive. 

http://www.docutracinc.com/kb/index.php?/
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 Referral Sources 
 
Note:  If you are using QDPM, you will want to setup the Referral Source via QDPM.  This information 
inputted into QuicDoc will not sync to QDPM.   
 
Referral Sources can be added 'on-the-fly' as you enter new clients, or you can set them up in the Referral 
Sources window. 
 
Setup Referral Source 
 
Select Referrals from the side View bar or top View menu. Click Tasks to open the list and select Add a 
referral, or you can select New Referral Source from the top Referral Sources menu. Enter information, 
and click Ok to save. 
Edit: Double click on name in list to open information form, or click Modify referral information on the 
Tasks bar. 
Delete: Select the name in the list. Select Delete Referral Source from right mouse-click menu or 
Referral 
Sources menu. Click Yes in dialog box to delete. If the referral source is associated with one or more 
clients, you will not be able to delete, instead you can make the referral source inactive. 
 

Patients 
 
Note:  If you are using QDPM, patients will be read only.  You will not be able to add, delete, or edit 
patients from QuicDoc.  Please refer to QDPM for any demographic changes. 
 
All that is required to enter a patient or client into the system is the first and last name and the provider. 
Other information can be added at any time. You can print a blank facesheet for your client to complete 
and then enter at a later time. 
 
In the Patient window click on Tasks to expand the list, and then click Add a patient, or select New 
Patient from the Patient menu. 
 
Enter information. Click on the tabs to add other information for the following categories. 
 

Personal tab 
Address tab 
Insurance/Referral tab 
Emergency tab 

 
Click the button to add Additional Information and User Fields. Click Ok to save. 
 

 User Fields: You can set up user fields to enter other information that you wish to record. This 
information will appear on the patient Facesheet. Information in the User Fields will also appear in 
Demographics reports. 
 
Click the User Fields button to setup fields. Press F1 for detailed information on adding fields and pick lists 
for your user fields. 
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Note for Network Users: User fields are global. If changed by anyone on the system, the change is 
reflected for all users and all patients. Assign the user field setup should be assigned to the SA or to one 
individual. 
 

Edit: Click Modify patient information on the Tasks listbar, or double click on patient's name, or 
select the name and press Enter to open Patient Information window. Make changes, and click OK to save. 
 

Creating Notes and Treatment Plans 
 

Once you've entered at least one patient you can begin doing intake notes, case notes, and treatment 
plans. You will need to log into the User created account.  The SA account cannot create notes.  
Numerous clinical sections allows for comprehensive record keeping. Most entry is done with 'point and 
click' or 'drag and drop' from extensive pick lists that are easily customized. Use your tab key to move from 
field to field. 
 
Depending on your system resources, QuicDoc's multi document interface allows you to have multiple 
notes open at the same time. You can resize windows, and close or minimize the patient window without 
closing your notes. 
In the documentation module you can record the following: 
  

Intake Notes   Treatment Plan - Outpatient 
Psychosocial History  Treatment Plan - Inpatient 
Progress Notes   Discharge Notes 

 
Note: Group Notes (Groups View) and Psychotherapy Notes (Documentation Menu) are entered and 
stored separately. 
 
To create notes and treatment plans: 
 

• First select the patient or client from the list. 
• Select New from the Documentation menu. Select the note type. 

 
As notes and treatment plans are created they are listed in the Notes or Treatment Plans tabs. By clicking 
the heading you open the list of notes or plans. To open a note or plan, simply double click on it. 
 

 
 
Documentation Basics 

 
Every note or plan type opens with either a Session Information or Discharge 

Information, in the case of a Discharge Note, screen to enter the date and other session 
information. Context sensitive instructions for entering information in the fields is 

displayed in green text as you move from field to field in the Session Information screen. 
The patient's name and the note type appear at the bottom, right of the window. 

 
Clinical sections relevant to the note or plan type are listed on the side bar. When you 
click on a section, a graphic pencil appears so you can easily see which sections you've 
opened. 
 
Click the headers or Bar Captions to open additional sections, such as Other Sections or 
Psychosocial History. 
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Enter Note Data Preview the Note 
 

 
 
Note View 
 
The Note view contains the clinical sections for entering data. You can arrange the clinical sections of your 
note or treatment in a specific order when generating it. You can also customize the side listbar for specific 
sections to be listed. See Help Files for details on setting note types or visit our online Knowledgebase. 
 
To generate and print your note, from the Note view select File...Generate Note... See below Generate 
Note/Report. 
 
Preview 
 
While doing a note or treatment plan, click Preview for an instant view of your note's progress. Preview 
generates your note at any point during the process or at completion. If you find that a section that was just 
filled out is not showing on the Preview go back to the Note view and click on the first section of the note so 
that the section that was just filled out is saved and then click on the Preview tab again, you should see 
that section show up at that point. 
 
From the Note View or the Preview you can send your note or treatment report to one of the following: 
 

Word Processor 

  Printer 

Portable Document Format (Adobe® PDF) 
 
Select File...Send to... Your note or report is generated as you see it in the Preview window. If you send it 
to a printer or a PDF file, you will not be able to edit it.   
 
Options for Generate Note/Report in Word Processor 
 
Click the icon at the top of the Preview window, or from Notes window, select File…Generate 
Note… to open the Generate Note/Report window to select and order the sections you want to include, as 
well as select page headers and other options, then send to a word processor. If you have a set order of 
clinical sections that you like to use each time you generate a note or report, you can set up sequences 
and save time when generating your notes. Click Create Sequences to set up. 
 
You may edit it or attach another file to your note by sending it to the Word Processor. However, be aware 
that changes made in the word processor will NOT be reflected back to the database. For example, if you 
change the 
Diagnosis in the word processor, it will not be changed in the database. To change the record in the 
database, click on Note, open the appropriate clinical section, and make any necessary changes. 
 

 
 

http://www.docutracinc.com/kb/index.php?/
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From the Generate 
Note/Report window, select 
the note sections you want to 
include by clicking on the 
section and then clicking Add. 
If you have created your own 
report sequences, you can 
select one from the sequence 
drop-down list. 
 
To include all sections, click 
Add All. To remove a section, 
select it from the sequence list, 
and click Remove. To reorder 
sections in the sequence list, 

select a section and use the Up or 
Down buttons to change the order. 
 
Select the Page Header text (e.g. Client Name and ID) to appear at the top of each page of the note or 
treatment report. 
 
If you have not setup a Report Header or want to change the Report Header click Set Report Header (blue 
text at bottom, center of window). The Report Header appears on the first page, at the top of your notes or 
reports. 
 
Click Patient Info Preferences (blue text at bottom, right of window) to set the information you would like 
to appear for each note at the top of page 1 (e.g. patient's age, address, etc.) 
 
Select Generate to send it to the word processor. 
 
Documentation Pick Lists 
 

 Click on the pick list icon in the upper right corner of a screen, when available, to edit a list while doing 
your documentation.  Press F1 while in the Edit list window for Help on adding, deleting, and editing items 
in the list. All pick lists can also be accessed from Setup menu and select Clinical Lists.   
 

 Spell check 
 
For Intake, Progress, Discharge Notes, and Treatment Plans: While your cursor is in any text field or drop-

down field, select Spell Check from the File menu, or click the Spell Check  icon. Spell Check checks 
only active fields. 
You will need to move your cursor from field to field to spell check all text fields. To replace a misspelled 
word, select a correction from the Suggestions list, if listed, and click Change. Click Change All if there is 
more than one instance of the misspelled word. You can also type your correction in the field, and click 
Change. 
 
Click Ignore or Ignore All to ignore the misspelled word. Click Add to add an identified misspelled word to 
the 
Dictionary. 
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Electronic Signatures 
 
By default, the note signature is turned off.  An admin will need to log in, go to Setup, and select 
Preferences.  Under the Administrative tab, there is a section called Electronic Record.  You will want 
to enable electronic signatures and/or require supervisor sign off. 
 
Note:  If you are using QDPM, ALL NOTES must be signed in QuicDoc for them to be sent over to QDPM.  
If notes are not signed, the charges will not sync to QDPM. 

Once a note is completed and is ready to be signed, click on the icon.  The Sign Note box 
will appear.  Here you can add/remove required signatures for providers and non-providers. 
 
There are 3 different types of Electronic Signatures: 
 

 this will use the current user that is logged into QuicDoc ID.  It will use the date 
and time that it was signed. 

 you may use a Topaz signature pad to sign notes.  Please contact Support at 
888-308-9683 for more details and system requirements before purchasing a signature pad. 

 this will allow the users to use the mouse or touch pad to sign a note. 
 
Supervisor Signatures 
 
Only one supervisor can be set for a user.  To setup a supervisor, login using an admin account.  Under 
Users, select the user in the list, and click on Modify user information.  Select the Supervisor in the 
dropdown menu.   
 
If you have custom notes, you will need to also allow supervisor signatures for these notes.  Login using an 
admin, under the Setup menu, select Documentation Setup, and click on QuicDoc Documentation.  
Select a Note Type and make sure that the Supervisor Must Sign is checked. Click Save. 
 
Note:  Once a clinical notes and reports are committed or electronically signed, they cannot be deleted or 
modified.  Any information that needs to be updated on a note must be entered into the Addendum. 
 
For more information on Electronic signatures, Supervisor signatures, or Addendums please visit our 
online Knowledgebase. 
 
Intake Note 
 
Select the patient or client, then from the Documentation menu select New...Intake Note. 
 

 By default, the Intake Sections are displayed on the side listbar under the Intake 
Note header. Click the bar to open the sections list, and then click on a section name, such as Previous 
Treatment, to open the corresponding screen. 
 

 Click on the caption bar labeled Other Sections at the bottom of the listbar, and 
then click a section to open a corresponding screen. 
 

 

http://www.docutracinc.com/kb/index.php?/
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 Click on the caption bar labeled Psychosocial History at the bottom of the listbar, 
then click a section to open it. 
 
You do not have to complete all sections. Once you have familiarized yourself with the sections, you can 
determine which areas you want to address. You do not have to go to every screen, or fill in every field. 
However, since the symptoms and treatment goals pick lists are based on the diagnosis(es) you enter, it is 
generally best to record the patient's diagnosis before addressing the symptoms and goals. 
 
Remember sections can be removed, added, or reordered.  Please visit our online Knowledgebase for 
more information. 
 
Progress Notes 
 
Select the patient or client then from the Documentation menu select New...Progress Note. 
 
Progress Note sections are listed under the side listbar. Click on a section such as Interventions on the 
listbar to open the corresponding window. 
 

 
 
Optional Sections is located at the bottom of the listbar, Click on it to open.  These sections contain 
information addressed at Intake which can be updated in progress notes. For instance, you may want to 
rate the symptoms and impairments to track improvement during treatment. Or, you may want to record 
progress toward treatment goals. 
 
Familiarize yourself with the sections to determine which areas you want to address. You don't have to go 
to every screen, or fill in every field. You can optionally enter a SOAP note. 
 
Remember sections can be removed, added, or reordered.  Please visit our online Knowledgebase for 
more information. 
 
Separate Psychotherapy Notes 
 
QuicDoc provides separate Psychotherapy Notes for therapists to keep sensitive information separate from 
the clients' records. Psychotherapy Notes can be password protected. To enter separate notes, select 
Psychotherapy Notes from the Documentation menu. Press F1 for detailed help in entering notes. 
 
Treatment Plans 
 
First select the patient or client, then from the Documentation menu select New...Treatment 
Plan...Outpatient or 
Inpatient. 
 

 As treatment plans are created, they are listed for each client in the Treatment 
Plans tab at the bottom right of the patient window. Click on the Header to open the list. 
 
Inpatient: The Inpatient Treatment Plan uses a Problem-Oriented approach, Problems with associated 
objectives, interventions or treatment modalities and the staff responsible. It contains a section for Hospital 
Justification, and a Summary section for discharge criteria, disposition, and a listing of the treatment team. 
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Outpatient: The Outpatient Treatment Plan by default contains the same clinical sections as the Intake 
Note, and it has the same sections contained in Optional Sections of the Progress Note. 
 
If you've completed an Intake Note on the patient, or updated those sections in the Progress Note, your 
most recent data will appear for updating in the Treatment Plan. Other clinical sections are listed on the left 
in the listbar. Click on a section to open the corresponding window. Other Sections can be accessed by 
clicking on the side caption or header labeled Other Sections, and then clicking a section to open the 
corresponding window. 
 
Discharge Notes 

 
First select the patient or client, and then from the Documentation menu select New...Discharge Note. 
Enter the Provider, Program, and the Discharge Date in the Discharge/ Session Information screen. Click 
an option for Discharge Status and for Discharge Condition. From the drop down pick list select a Reason 
for Discharge, or you may type in the field. 
 
For Total Sessions Seen, select either Total Sessions or Hospital Days, and then click the Calculate 
button. Only documented sessions, as well as the Intake will be included in this number. You can override 
the number by simply typing in the field. 
 

  Click the tabs for Discharge Recommendations and Summary to complete the 
Discharge/Session information.  Additionally other documentation sections can be addressed at discharge. 
 
A Discharge Note must be entered before creating a new incident. 
 

Batch Printing Clinical Notes and Treatment Plans 
 

You can batch print notes listed in the Notes History, Treatment Plans, or Incidental tabs, in the Patient 
window. Batch printed notes and reports are generated from the database. You cannot edit nor order the 
note sections. All sections that were addressed when the note(s) were created will be printed. If you want 
to edit and control the order of note sections, generate each note individually and send to the word 
processor. To print a ‘Selected’ note, or to ‘Batch’ print all notes from the Patient window, select 
File...Print...Notes. 
 
Print Selected Note 
 
Select the client whose note you wish to print. In Notes, Treatment Plans, or Incidental tab, click on the 
Note or 
Report to select it. Select File...Print...Notes. Click OK in the Print Notes dialog box to send the note to a 
preview window for printing. 
 
Note: By default the first note or report in the tab is automatically selected, be sure the note you want to 
print is selected. 
 
Print All Notes or Notes in a Date Range 
 
Click the All Notes option to batch print all notes or reports in the selected tab (Notes, Treatment Plans, or 
Incidental) for the patient, or click the Notes and specify a From and a To date. 
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Set a Header. If there is no option for a header, or none appears in the Select Note Header area, then 
none was setup. If there is more than one header, use the browse arrows to display the header you want to 
use. 
 
Click in the checkbox if you want to have a 'Page Break between notes.' 
 
Click OK to send notes to a print preview. Click Print to print the note(s), and Click Close to exit. 
 

Group Notes 
 
Before setting up a Group, be sure that the Leader and Co-Leader, if applicable, have been setup as Users 
in 
QuicDoc. For more information on Groups, please visit our online Knowledgebase. 
 
Note:  If you are using QDPM, Group note charges will not sync to QDPM.  All charges for Groups must be 
entered manually into QDPM. 
 
Click Groups on the side listbar under Views, or select Groups from the top View menu. 
 
Setup a Group 
 
To setup a group, from the Groups menu select New Group. Enter a Name for the group and enter a 
description in the text field. 
 
Use the drop down pick lists to enter a Leader and a Co-Leader, assuming that the therapists have been 
added in the User setup. 
 
Select a Note Type from the drop down list as this is required to save the Group. 
 
Note the Active checkbox, and be sure it is checked. You can un-check once the group terminates. 
 
Add Members to Group 
 
Click the Add button in the Group Therapy setup window to enter group members. Drag names from the 
Patient 
List to the Group Members List, and click Ok to save. 
 
Search: If the client list is long, you can search for a specific client by typing in the Search field, and 
clicking on the binoculars. 
 
Once set up, the group is listed along with the group members in the left pane of the Groups main window 
under 
Group Listing. Click the + plus next to the group name to expand and display the list of members. Click 
again to collapse the list. 
 
Edit Group Information and Membership: To edit the group name, the leaders, or the membership right 
click on the group name and select Edit Group, or select it from the Groups menu. 
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Member Status 
 
To view or change a member's Active and Inactive Status: Double-click on the member's name in the 
group listing, and check or uncheck the Active checkbox. 
 
To change the status from Active to Inactive, un-check the Active checkbox. Enter a date in the Ended 
Group date field to record the date the client terminated the group. 
 
Creating Group Notes 
 
First select the group name in the list. From the Group Notes menu, select New Group Note. 
 
The Group, the Leader, and the Co-Leader names, (if entered at setup) as well as the Date are 
automatically filled. Change the date if different. 
 
Use the drop down pick list to select a program, if applicable. 
 
The Length field is automatically calculated, once you enter the Start and End times. 
 
Set Attendance 
 
Group members are listed with a set of check boxes next to each name. By default all members are 
checked as 
Attended. 
 
Select Missed, Cancelled, or Not Scheduled for any member where it is appropriate. 
 
If Attended is selected, you can do a group note. If Missed or Cancelled is selected, you can write a note 
indicating the reason. If Not Scheduled is selected, no note will be required. 
 
General Group Note 
 
Group Notes consists of two sections. A Group Information section that has the date, time, program, and 
the attendance status.  The other section is Group Note Content.  You will enter the session notes in this 
section.  
 
Enter Themes, Interventions, and/or Content for the group session. You may click on the Note for All 
Members which will allow you to enter all information for the themes, interventions and content for all 
members of the group.  To assist with spelling errors QuicDoc's Group Notes has spell check as you go. 
When completed, click the Next button to save the group note. 
 
The Details section is for each patient and must be entered for all members. 
 

Interactions with other Members/Leader(s) 
Level of Participation 
Symptoms/Problem Focus/Behavioral Change 
 

Click on the member's name in the list on the left to access that member's note to add patient specific 
details. 
 
Close out of the note to Save.  
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Notes are listed in the lower right pane of the main QuicDoc interface under the Group Notes tab. You can 
open a Group Note listed here by double-clicking on it. 
 
Create Individual Notes only for a Group Session 
 
If you wish to enter notes for each individual member in the group, and do not want to include a 
generalized note, do not use the ‘Note for All Members.’  You will enter the session information in all the 
required text fields. 
 
Print: To print group notes for all members, click the Print All Notes button. Selecting this will print what 
has been entered in both the General and Details tab for each member. If you have entered a Missed or 
Cancelled note for a member, this will also print. 
 
Clicking the Print Selected button will print what has been entered in both the General and Details tab for 
the member selected in the list. 

 

QuicForms Treatment Plans 
 

Use QuicForms to import your data from QuicDoc onto insurance or managed care company’s required 
treatment plan form. QuicForms comes with a number of OTR forms which will need to be installed before 
they can be used. When opening QuicForms for the first time, follow the instructions on the screen to install 
form files. 
 
To open QuicForms from QuicDoc: Click the QuicForms icon on the toolbar, or select QuicForms from the 
Documentation menu. 
 
Filling Out Forms 
 
Once forms are installed they are listed in the QuicForms opening screen, in the left side pane. Click on a 
form to view it. Since forms can be similar, you can preview the form before opening it. When you open a 
new form you have the option to import information from QuicDoc, or to fill out the form from scratch. 
Forms have pick lists and calendars for quick entry. 

To open a form, click on it to select it, then click the Open  button on the toolbar, or select 
File…Open. 
 
To Import from QuicDoc 
 
Select Import from QuicDoc in the New Record window when opening a new form. This allows you to 
import data from one of the notes or treatment plans previously entered in QuicDoc. 
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Select a client from the list of 
patients/clients. 
 
Next, select the Note/Plan Type to 
import (e.g. Intake, Progress, 
Treatment Plan, or Discharge Note). 
You will then see a list of dates for 
possible notes or plans to import. 
 
Under Select Note/Plan Type, click on 
the row with the date of the note or 
plan you want to use to import the 
data. Click OK. 
 
Note: All required data may not 
transfer to a particular form due to 
differing formats used to store 

QuicDoc’s data. Also, there may be some data which QuicDoc does not collect. However, much of the 
basic data will be transferred. 
 
Many of the form fields have pick lists and calendars making it easy to fill in the forms. The status bar at 
the bottom of the form indicates if the field has an associated pick list or calendar. To access the pick list or 
calendar, double-click in the field or press F8. 
 
All forms included in QuicForms function in the same way. Use the TAB key to move from field to field, or 
click in a field. When a field is active, it will change color. Check boxes can be selected/de-selected by 
clicking them with the left mouse button. 
 
Since the form is larger than the size of the screen, you can scroll horizontally or vertically by using the 
scroll bars at the bottom and to the right of the form. Clicking on the arrows on the bar moves the form 
slowly. Clicking between the arrows and button on the bar moves the form more quickly. 
 
To display the next or previous page, click on the Page number buttons at the bottom of the form. 
 
Note: When entering data in multi-line text boxes, if the height of the text is higher than the height of the 
box or scrolls below the text box, the entire text will be printed on an additional page, appended to the 
form. 
 
New Treatment Plan Record 
 
Once a form has been opened and saved, the next time you open that form you will see you’re previously 
saved treatment plan(s). To create a new record: 
 

 Click New Plan on the Navigation toolbar, or select Records…Go to…New Record. 
 
Select the option to Import from QuicDoc or to open a Blank Treatment Plan. 
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Saving 
 
 

 To save the treatment plan record in QuicForms, do one of the following: To save a plan you have 
completed, select Records...Save or click on the Save icon on the toolbar. 
 
Each treatment plan form has its own database to store plans. A database is a collection of information 
stored as individual records. QuicForms automatically creates a database, and the first record in the 
database, when you open the form for the first time. Each time you do a new plan, it becomes a record in 
that form’s database. Form databases are installed in the QuicDoc/Data folder. 
 
Problem-oriented format 
 
Some OTR forms require use of a problem-oriented format. That is, entry of one or more problems, and for 
each, associated goals, objectives, and interventions. When importing from QuicDoc, this data will come 
from the 
Problems-Objectives-Interventions section of QuicDoc. Otherwise, goals and interventions will come from 
the 
Treatment Goals and Treatment Planning sections respectively. 
 
Navigating Saved Plans 
 

Each new plan is added to the end of the database 
record set. You will notice that when you create a new 
plan or save a plan the record count at the top of the 

screen changes. The Record Count (Record 3 of 3 in the example) on the navigation bar displays the 
number of records in the current database.  You can go to a specific treatment plan by opening the form 
and using the record navigator, pictured above, to move to the desired record, or use the find feature to 
locate a record. 
 
Note: The Records...Go to menu corresponds to the navigation buttons on the toolbar. 
 
Duplicate 
 
QuicForms make it very easy to update a previously saved treatment plan. You can duplicate an existing 
plan and eliminate double entry of information which remains constant. 
 
When first opening QuicForms, select the Treatment Plan you want to use from the list of treatment plans, 
and click the Open button on the toolbar. Use the navigation bar at the top to select the record that you 
want to duplicate. 
 
Select Duplicate from the Records menu. 
 
The original plan will be duplicated and added to the end of the database. You can then make changes to 
update the plan, and save it. 
 
QuicForms Preferences 
 
To set preference options in QuicForms including printer offsets, select File... Preferences. Press F1 for 
Help on options. 
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Adjust Field Positions 
 
On some forms, the field positions may not be perfectly aligned or when printing the form, the data 
alignment may be off. This can be corrected by adjusting field positions and re-saving the form file. 
 
Select Adjust Field Positions from the QuicForms Tools menu. Use the arrows on the Nudge Pad for 
positioning. Press F1 for Help. 
 
Deleting a Record of a Treatment Plan 
 
To delete a record, go to the record in QuicForms that you want to delete. Select Delete from the Records 
menu, or press Ctrl + d. 
 
Spell Check 
 
To spell check all text on a page, select Tools...Spell...Check Page, or select Check Field for checking a 
specific field. 
 

Outcome Measures 
 

QuicDoc includes built-in measures to track progress and evaluate treatment outcomes for your clients. In 
addition you can enter scores for any measure, including user-defined, and QuicDoc will track client 
progress, as well as generate aggregate reports and graphs for that measure.  For more information on 
Outcome Measures, please visit our online Knowledgebase. 
 
 
To Print Copies of Measures for patients to fill out: 
 
QuicDoc comes with the following built-in measures: 
 

Health Status Questionnaire (HSQ) 
Outcome Questionnaire-45 (OQ-45) 
Timberlawn Child Functioning Scale 
 

Select Print... Measures, Forms, Letters from the File menu, or click the Print button on the toolbar. 
 
Following are the names of forms and measures you can print: 

Patient Satisfaction Survey.rtf 
Health Status Questionnaire.rtf 
OQ45.rtf 
Timberlawn Child Functioning Scale Parent Version.rtf 
Timberlawn Child Functioning Scale Therapist Version.rtf 
Crisis Triage Rating Scale.rtf 
 

Select the file from the list of files in the Documents tab in QuicDoc, and double click Open. The document 
opens in QuicWord. Select Print from the word processor File menu. Print one or more copies. 
 
You can also open the word processor from the Write menu to print measures. 
 
Select Open from the QuicWord File menu. 
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Other Measures 
 
In addition you can set up your own measures. QuicDoc also provides screens with scale names and fields 
for entering the score or rating, T scores, Raw scores, or in the case of the Zung Depression Scale the 
SDS Index. 
QuicDoc does not score and interpret these measures, but you can administer them and enter the results 
so that 
QuicDoc will track progress. The following are pre-defined measures listed in the Measures pick list 
window: 
 

Addictions Severity Index 
Basis 32 
Beck Depression Scale 
Geriatric Depression Scale - Long Form 
Geriatric Depression Scale - Short Form 
SCL-90-R 
Zung Depression Scale 
 

Setup outcome measures 
 
Select the patient. From the Assessments menu select Outcome Measures. 
Click the Add button. 
 
Double click on a measure to select it from the Measure list, or highlight it and click Select. There is no 
limit to the number of measures you can use. You can even use other measures that are not in QuicDoc. 
First, you will need to set them up as user-defined measures. They will then be added to the Measures list. 
 
Score the measure after setting it up for the patient. Only when a measure is scored does it becomes 
associated with the patient. If you select a measure for a patient, then close the Outcome Measures 
window before scoring it, the measure will not be listed when you open the form again. 
 
Score Measures 
 
To score, select the patient, then select the measure to score form the Outcome Measures window, 
Assessment menu. 
 

Click the blue underlined text Score. 
Enter the date. 
Enter the phase of treatment: 1 baseline, 2 progress, or 3 discharge. 
To associate the scores with a particular session, click down arrow in the Assoc. with session field, 
and select a date from the drop down pick list which displays all documented sessions. The 
corresponding session number for the date selected is entered in the field. 
Enter item responses or scale scores. For measures in QuicDoc, enter the responses in the 
questionnaire; for Pre-Defined or User Defined measures, enter the scores. 
Select Save for questionnaires, or OK to save scores entered. 
 

Click the blue underlined word Review for a report and graph of the measure. 
 
User Defined Measures 
 
You can setup your own measures to use, and QuicDoc will provide the forms for entering scores, and will 
generate graphs and reports. Click Add as you would to select a measure. 
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 In the Measures window click the User Defined…button. 
 
Click New in Outcome Measure Setup. 
 
Enter the following information: 
Measure Name: Enter name of measure 
you want to use. 
 
Score Type: Enter Type of Score (e.g., 
T-score) from drop down list. If not listed, 
type it in. 
 
Range of Scores: (e.g., from 0 To 50). 
Enter lowest and highest number of 
scores for all scales and subscales. 
 
For example, a measure may have three 

subscales with scores in different ranges: the first with a range from 10 to 20, the second from 0 to 20, and 
the third from 10 to 30. The Range of Scores would be from 0 to 30, the lowest and highest scores of all 
three subscales. 
 
ID and Scale Names: 
 
Enter ID and Scale Name in the fields at the bottom of the form. 
Click Add to add to the Scales list box. Click Save after entering all required information for the measure. 
Click New to add another measure, or Cancel to close the setup form. Forms for entering scores are 
generated when you select the measures for scoring. 
 

Score and Print Patient Satisfaction Survey 
 

Select Patient Satisfaction Survey, New from Assessments menu. 
 
Enter Information: 

Date: Enter patient's Discharge date or approximate Discharge date. 
Provider: If access to All Providers is allowed, there will be a drop down list to select the provider. 
Otherwise, the field will display the name for the logged on user. 
Program: Select from drop down list. 
Insurance Co.: Select from drop down list. 
 
The information is used to filter reports and graphs. 
 

Enter Scores: 
Enter a rating for each item. 
 

Calculate and Save Survey Scores: 
Click Save to calculate scores. Scores are displayed at the bottom of the form. 
 

Note: Individual survey results can only be printed at the time the scores are calculated. 
 
Click Print to print the survey results with item ratings, total score, and sub scale scores. 
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QuicDoc Scheduler 

 

 Launch the Scheduler from the toolbar or the File menu. You can view the schedule in the following 
ways: 
Day view, Week view, Month view, and All Providers view (requires Administrative logon or access rights). 
 
Note:  If you are using QDPM, the scheduler will be read only.  You will not be able to add, delete, or edit 
appointment from the QuicDoc Scheduler.  Please refer to QDPM for any appointments or demographic 
changes. 
 
Click to expand the Views side listbar and select a view, or select it from the View menu. 
 
This start-up guide will cover just the basics of entering an appointment and then making it a repeating 
appointment. QuicDoc’s Scheduler has many features including appointment status with a checked–in 
feature, room scheduler, event scheduler, group therapy appointments, appointment slips, scheduling 
availability and blocks of time, reports, tasks and numerous other features. 
 
Creating an appointment 
 
Note:  If you are using QDPM, the scheduler will be read only.  You will not be able to schedule an 
appointment in the QuicDoc Scheduler.  Please refer to QDPM on creating, deleting, or editing any 
appointments or demographics. 
 
Click a time slot while in the day or week view in the Scheduler, and then drag your mouse to select a time 
block. 
 

 From the Appointments menu, select New Appointment, or right click for a pop-up menu. You can 
also click the Add Appointment button on the toolbar. 
 
Select Schedule Patient. You can also schedule a Group, Event, Appointment Types, or Availability. 
 
Schedule a Patient 
 
Note:  If you are using QDPM, the scheduler will be read only.  You will not be able to schedule an 
appointment in the QuicDoc Scheduler.  Please refer to QDPM on creating, deleting, or editing any 
appointments or demographics. 
 

 If scheduling a client that has already been entered in QuicDoc, click the drop-down arrow, to 
the right of the Patient field and select the name from the list. If not on the list, you can add a new client 
from the New 
Appointment window. Click the Add New Patient button. The first name, last name and the provider are 
the only required fields to add the patient. Once you have added the patient, click Ok to save. To enter 
complete information for the patient, go to QuicDoc's main Patients window. 
 
Enter additional information (e.g., status, service, location) and the Start and End Times. 
 
You can simultaneously schedule a room for the appointment. See the Help files or our online 
Knowledgebase for more information. 
 

  

http://www.docutracinc.com/kb/index.php?/


 

 

 

Advanced EMR and Billing Solutions for Behavioral Health              pg. 27 

 

Repeating Appointments 
 
Note:  If you are using QDPM, the scheduler will be read only.  You will not be able to set repeating 
appointments in QuicDoc Scheduler.  Please refer to QDPM on creating, deleting, or editing any 
appointments or demographics. 
 
Click on the appointment after it is created to select it. Then right click for a pop-up menu and select 
Repeating 
Appointment, or select it from the Appointments menu. 
 
Pattern of Repeating Appointment 
 
Select an option for daily, weekly, monthly, or yearly. 
 
Daily: Select an option for Every weekday, or Every___ day. The Every___day option allows you to enter a 
number for the frequency, for example if you want to set up an appointment for every 2 or every 3 days 
which includes week ends. 
 
Weekly: Allows you to set up the frequency, as well as the day on which you want to schedule the 
appointment, for example - every second week on a Tuesday. 
 
Monthly: If you want an appointment for a specific date each month, such as on the 15th, enter the 
number in the 
Day field. If you want the appointment scheduled for every month, be sure the number 1 is in the month(s) 
field. 
 

Note: if you enter 30 for the day, and February falls within the parameter of the repeating 
appointments, there will be not appointment scheduled in February, since there is no 30th of 
February. 
 

Select the second option if you want the appointment to fall within a specific week of the month, for 
example the second Wednesday of each month. Select the week and the day from the drop down pick 
lists. If you want the appointment scheduled for every month, be sure the number 1 is in the month(s) field. 
 

Note: Be careful in scheduling a specific day within the first and last weeks of the month since the 
selected day may not fall within that week on every month. 
 

Yearly: To select a specific month for the appointment, click the first option and select the month from the 
drop down pick list. To select a specific day, such as the second Tuesday in March, select the week from 
the drop down pick list. Then select the day from the drop down pick list. Then select the month from the 
drop down pick list. 
 
Date Range 
 
Enter a Start Date; by default the selected appointment's date is displayed. 
 
Enter an end number to End After a specific number of Occurrences, or you can enter an End Date. 
 
Sample Dates 
 
Click the Sample Dates button after you have setup your repeating appointment to view the dates. 
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Backup Recommendations 
 

Back up your data on a daily basis. If your computer has more than one hard drive, back up onto a drive 
other than the one in which your working data is stored. If you have only one hard drive, back up onto an 
external drive. Remember, an important reason for backing up data is to protect against a hard drive 
failure. 
 
We recommend that you make backups daily on external drive to keep in the office as well as off site. 
 
Minimally, at least once a month, make a backup copy to keep off your premises. 
 
Backup Utility 
 
QuicDoc cannot be running when you backup the databases. If QuicDoc, QuicForms, or the QuicDoc 
Scheduler is running, select Exit from the File menu. If running on a network, make sure all users are 
logged off of QuicDoc before running the backup program. 
 
If you use any attachments, you will also want to backup this location to an external drive.  To find your 
attachment location, log into the SA account, go to Preferences, and under the Administrative tab there will 
be an attachment location. 
 
For assistance on backing up your database and QuicDoc files, please visit our online Knowledgebase. 
 
Note:  If you are using our Cloud services, we have the worry-free automatic backup and disaster recovery 
provided for you.  You do not need to worry on backing up your QuicDoc attachments or database. 
 

 

http://www.docutracinc.com/kb/index.php?/

